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[bookmark: _Toc80273946]Overview of the Facilities and Using the Software
This Help file provides a manual for the facilities available in the JSP101 software and is for versions of Word from 2007 onwards.  It works with 32 and 64 bit software and has been tested up to version 2016 (Office 365).
Within Word it is not an easy matter to get a consistent paragraph formatting and numbering style automatically.  The JSP101 system provides a straightforward way of achieving this, to the Defence Writing standard.  It also provides the basis for simple common documentation.
This system does NOT enforce any Defence Writing rules, such as a document can never have a sub-paragraph unless there is a top level numbered paragraph first, it merely provides the facilities for achieving the rules in an easy to use and flexible environment.
Help is available in the form of this manual at any time you are using the system either from the button on the ribbon or by using the keyboard shortcut Alt+O.  Many of the dialogs that appear when using the JSP101 facilities have a button marked Help which also opens this manual.
The software provides the following facilities, allowing the user to:
Create common documents such as Reports, Agendas, Minutes, Briefs, Notes, Submissions and Letters.
Apply automatic Formatting for Headings and Numbered or Un-Numbered Paragraphs.
Add automatic Page Numbering and Protective Markings/Descriptors to a document.
Create or delete an Annex or Appendix in a document.
Add a cover sheet and insert a footnote.
Change Line Spacing, Text Alignment and document Font.
The system can also be easily applied to any existing document.
The facilities are all available from the File/Add-Ins menu and from the purpose built ribbon tab.
The paragraphs can be moved around, deleted or corrected at will and the paragraph numbering will be re-formatted correctly.
Each of the buttons on the ribbon has a ScreenTip which is displayed when the cursor is placed on the button itself and is a short reminder of what the button does.

[bookmark: _Toc80273947]Using the Software
After installation there will be 2 new menu options.  In Word 2010 and later they will be found on the 'Add-Ins' option under the 'File' tab.  The first called New JSP101 Documents provides 3 options on a sub-menu.  The top one opens a new blank document with the JSP101 facilities attached.  This is for general purpose reports to be written to Defence Writing standards.  The option ‘New Document’ is for the creation of the 6 types of document – Agenda, Minutes, Brief, Note, Submission or Letter.  See the help topic Document Templates for more details on how to use and edit these.
The bottom option is covered under Applying the Template to an Existing Document.
See Also:	General Rules for Ease of Use

[bookmark: _Toc80273948]The JSP101 Ribbon
The JSP101 Ribbon tab can be found at the left end when a document based on the JSP101 template is active.

[image: ]

If the cursor is moved over any of the options, a dialog gives a short explanation of the function and shows the keyboard shortcut key associated with it, as described below.  All the main functions have their own button on the ribbon with the exception of those that are less used which appear under the Other Functions dropdown.  These are documented below here.



[bookmark: _Ref385258991][bookmark: _Toc80273949]Hot-Keys or Keyboard Shortcuts
The Hot-Keys or keyboard shortcut keys are the key combinations that can be used as short cuts to applying one of the styles, or calling one of the routines.  They are all a combination of the Alt key and another letter or number, i.e. hold the Alt key down and press the letter/number required.  These do exactly the same job as clicking the relevant button on the Ribbon.
Alt+M		applies the Main Heading Style
Alt+S		applies the Subject Heading Style
Alt+T		applies the Title (or Group) Heading Style
Alt+B		applies the Bullet style
Alt+N		changes the paragraph to Normal Style
	(un-numbered with no following blank line)
Alt+P		changes the paragraph to Plain Text Style
	(un-numbered with a following blank line)
Alt+1		applies the level one numbering
Alt+2		applies the level two numbering
Alt+3		applies the level three numbering etc down to level 5
Alt+H		numbers the paragraph at the next Higher level
Alt+L		numbers the paragraph at the next Lower level
Alt+U		moves the paragraph Up to swap with the one above
Alt+D		moves the paragraph Down to swap with the one below
Alt+O		Opens the On-line help manual
Alt+A		Opens the About dialog
Alt+G		Adds a paGe number
Alt+V		Allows addition of priVacy marking/descriptors
Alt+X		Adds a new AnneX or Appendix

See also:	Paragraph Numbering

[bookmark: _Ref385260217][bookmark: _Toc80273950]Headings
[image: ]There are 3 heading types available in the system. 
The ‘Main Heading’ is by default bold centred text.  This heading is not often used except when writing a long detailed report and there is a requirement for a heading that describes what the report is about.  Because a Main heading can consist of more than one line, when the ENTER key is pressed the following paragraph will also be formatted as a Main heading.  Just press ENTER again to turn this off.
The ‘Subject Heading’ is by default bold capitals which is left aligned.  Again this heading is normally only needed for long detailed reports where there are several sections of the report requiring a heading that describes what that section is about.  When ENTER is pressed after a Subject heading, the next paragraph will automatically be a numbered one but this can simply be changed if required.
The ‘Title Heading’ (also called a Group Heading for longer reports) is the most usual heading used in normal documents.  By default it is bold text left aligned and is the title for a number of paragraphs.  When ENTER is pressed after a Title heading, the next paragraph will automatically be a numbered one.
Any paragraph can be turned into any of these headings by using the Ribbon button or via the appropriate hot-key – Alt+M for Main heading, Alt+S for Subject heading or Alt+T for Title heading.

[bookmark: _Amending_Heading_or][bookmark: _Toc80273951][image: ]Amending Heading Formats 
If for any reason the format of these headings needs to be changed – perhaps you want a Main heading to be capital letters or underlined – then there is a routine to allow this.  Perhaps not strictly JSP101 but it gives you the choice! 
[image: ]From the Other Functions menu on the Ribbon there is the option Amend Heading Formats.  This will show the form shown here which is self-explanatory and if the settings are changed and ‘Apply’ clicked, you will be given the option to save the settings for all future documents.  If you click ‘No’ then the values chosen will be applied to the current document only.
The ‘Help’ button simply brings up this help manual. 

[bookmark: _Toc80273952]Paragraph Headings
A paragraph heading cannot be completed automatically in the JSP101 template.  It would be more complicated to have an automatic system than to simply highlight the text for the heading and click the bold button!
Remember a paragraph heading is optional, but if used a heading is bold and followed by a full stop.  Follow the rules in part 2 of the Defence Writing manual.

[bookmark: _Paragraph_Numbering][bookmark: _Ref385260190][bookmark: _Ref385260609][bookmark: _Toc80273953]Paragraph Numbering
There are 5 possible levels of automatic numbering defined in Defence Writing and the formatting for each of these has been built into The JSP101 template as a particular style name.
The levels are:

	1.
	Level 1 or Top Level

	   a.
	Level 2

	      (1)
	Level 3

	         (a)
	Level 4

	             i.
	Level 5



The style names are "Heading 1" for the top level paragraph, "Heading 2" for the level 2 sub-paragraph etc.  The names have got to be Heading x because that is the name that Word gives to the styles in order to get automatic numbering correctly!
You do not really need to worry about what the style is called, since it is possible to choose the paragraph level with the simple Hot-Keys of Alt+1 for level 1 (top level), Alt+2 for level 2 etc, or by simply clicking on the Ribbon buttons of Number At Next Higher Level or Number At Next Lower Level.
If you do not want paragraph numbering for any reason, then there are 2 un-numbered styles that you can use.  (See Turning Off Paragraph Numbers below)
Within a paragraph, the text will wrap onto the next line as usual, but at the end of the paragraph when ENTER is pressed, there will be an automatic blank line inserted for all numbered paragraphs.  The following style will be the same and will therefore give you the next paragraph or sub-paragraph number automatically.
If ENTER is pressed at an empty paragraph – i.e. the cursor is placed at the start of the paragraph (after the number) and there is no text in the paragraph – then the previous level paragraph number will be automatically selected and if the level is already top level, the paragraph will become an un-numbered one.
See the section Tab and Enter for more details.
At any time should a different level of paragraph, or one of the headings, be required then simply change the style using the Hot-Keys, or Ribbon.
Remember any paragraph style can be changed into any other paragraph style easily.

[bookmark: _Turning_Off_Paragraph][bookmark: _Ref385262639][bookmark: _Toc80273954]Turning Off Paragraph Numbers
Should you, for any reason, wish to turn off paragraph numbering then there are 2 un-numbered styles provided.  The button on the Ribbon is a menu button that gives the 2 options.  One formats the paragraph as ‘Normal’ with no following blank line and the second formats the paragraph as ‘Plain’ text with a following blank line.
Choose the one which best suits your needs by selecting from the ribbon options or by using the Hot-Key Alt+N (for Normal Style) or Alt+P (for Plain Text Style).  All other paragraph numbers will be re-numbered correctly.
The system will also detect where the ENTER key is pressed on an empty top level paragraph and automatically turn it into an un-numbered paragraph.
Thus if you want some space within your document to insert a table or diagram within a numbered paragraph for example, press ENTER to get a new paragraph (with a new number), press ENTER again to change this automatically to No Number Style.  Insert your table or diagram etc. and when you want to go back to Paragraph Numbering or a new Heading, then merely click a button on the ribbon or press the appropriate hot-key.

[bookmark: _Wrong_Paragraph_Numbering][bookmark: _Toc80273955]Wrong Paragraph Numbering 
Word can be inconsistent when it comes to changing paragraph numbering, especially when numbering needs to be re-set at any point.  Under Defence Writing, a new annex or appendix re-starts its paragraph numbering at 1 and sub-paragraphs always re-start after every higher level paragraph.  The JSP101 system attempts to make sure the paragraph numbering for each section is re-set as required, but there are times when Word decides that the numbering should continue from the previous section of the document, particularly for sub-paragraphs! This is more likely to happen when text is pasted in from somewhere else.  Also, Word can sometimes show the sub-paragraph indents wrong and instead of being 1cm they are shown as 2cm.

You must check your document – particularly with annexes/appendices or when text has been pasted in – for this “wrong” numbering or indentation and use the options provided to correct it.  The 2 functions are described below.


[bookmark: _GoBack][image: ]The tools to help with this are on the JSP101 ribbon, as shown here, from the Wrong Numbering menu in the ‘Paragraph Numbering’ section.  The bottom option Wrong Numbering Help simply opens this help file here.  The other 2 options deal with the 2 ways that paragraph numbering can go wrong.

[bookmark: _Toc80273956]Restart Numbering 
This re-sets the current paragraph number back to the list start.  The ‘start’ depends on what level of paragraph it is – 1. for top level, a. for first sub-paragraph etc.  For example, if the sub-paragraphs are as shown here:

4.	This is the text in paragraph 4 which has been correctly numbered following 3. etc

	c.	This should now be sub-paragraph a. but has been numbered c. following the previous section where there were sub-paragraphs a, and b.

	d.	The next sub-paragraph which should be b. etc

5.	This paragraph is again correct.

You need to re-set sub-paragraphs c. and d. back to a. and b. so put the cursor in sub-paragraph c. and choose the first option Restart Numbering.  This should do the trick!

[bookmark: _Toc80273957]Correct Numbering
However, the numbering can get very muddled and you have a mixture of numbers that are not in order and sometimes occurs when sub-paragraphs are inserted into the middle of an existing list, because Word thinks that this is a new list.

So, for example if you get the following situation shown in the left picture where numbering has gone wrong:

[image: ][image: ]
Select the block containing the ‘wrong’ numbering or indenting as shown on the right (it doesn’t matter that para 4. is correct) – this selection can be any size and cover multiple different paragraphs.
Now choose the second option Correct Numbering.  You will get a dialog that explains the function, so click ‘Continue’ and the block should now be re-numbered correctly and the cursor will be left at the block start.

[bookmark: _Toc80273958][image: ]Wrong Indenting
Also, sub-paragraphs can sometimes appear indented too much – particularly when opening older documents.  Instead of being indented by 1cm, sub-paragraphs are shown on the right indented by 2cm.  This can also apply to sub-sub-paragraphs and bullet paragraphs.  Simply select the block as for the case of wrong numbering described above and choose the Correct Numbering option.


[bookmark: _Toc80273959]Moving, Deleting or Inserting Paragraphs
If you need to move paragraphs around, delete or insert them, the paragraph numbering will remain correct.
To insert a paragraph, simply go to the end of the previous paragraph (or to the start of the paragraph that will follow) and press ENTER.  A new paragraph will appear and if the numbering level is wrong, just change it (see Paragraph Numbering).
To delete a whole paragraph, select it and press the Delete key (or use the normal Edit Cut or Copy etc).  This may then just leave the paragraph number which can be deleted with the normal Backspace key.  If you just wish to join 2 paragraphs together, i.e. delete the paragraph number in the middle, then go to the start of the second paragraph and press the normal Backspace key.  Sometimes this will cause the numbering level to change, so if it is wrong change it with the appropriate hot-key or ribbon button.
To move text around, you can use the normal Drag & Drop or Cut & Paste as usual, but if you want to move a whole paragraph up or down, the Move Paragraph Up (hot-key Alt+U) and Move Paragraph Down (hot-key Alt+D) buttons on the Ribbon provide a useful shortcut.  Make sure the cursor is in the paragraph you want to move (you do not need to select the whole paragraph) and then click the appropriate button.  The whole paragraph will move 1 place up or down and further clicking of the button will repeat the process.  If the level of numbering is then wrong, merely change it with the appropriate button or hot-key.

[bookmark: _Page_Numbering][bookmark: _Toc80273960][bookmark: _Ref385263036]Bullet Paragraphs
Defence writing allows bullet points within a document to show a list of points.  The template has the ability to change any paragraph into a bullet style.  Use the option on the ribbon or use Alt+B to change a paragraph to this style.  Pressing ENTER on an empty bullet paragraph will revert to top level numbering.
A bullet paragraph is indented, but if this needs to be changed for a specific document then this will have to be done by hand.

[bookmark: _Toc80273961]Page Numbering  
Page numbering in Word is straightforward, as long as you do not want to change the format half way through!  That is normally what is required when an Annex is needed and the page number format changes.
Under the latest Defence Writing Guide, page numbers are placed in the page footer on the right side.  So any new document or annex/appendix created will have the page number inserted in the correct format, except for the plain report document.  However if this needs to be done manually then click the button on the Ribbon or use the hot-key Alt+G.  If this is a single page document and local rules say there is no page number, then simply delete the number in the footer.  A page number is not added to a cover page automatically but can of course be manually added to the footer if required.
Be aware that this routine will add a page number to every part of the document except a cover sheet.
If page numbering is on and then later it is not needed in any of the document parts, you will have to manually delete the page number field from the footer.
Adding a page number does not affect any Protective Markings/Descriptors that are inserted and the footer will be set up correctly with the Protective Marking in the centre and the page number on the right.
If you want the total number of pages in the whole document, from the Insert group click the Quick Parts option in the Text section, choose Field and find NumPages.

[bookmark: _Annexes_and_Appendices][bookmark: _Ref385260668][bookmark: _Ref385261230][bookmark: _Toc80273962]Annexes and Appendices 
An Annex or Appendix is sometimes required after the main document  where supporting information is detailed.  The process of creating the format for an Annex or Appendix is done automatically with the JSP101 system.
The button on the Ribbon, or the hot-key Alt+X, is a short cut to inserting a new Annex or Appendix into your document, with the correct headings and page numbering.
[image: ]A dialog box is presented asking for the details shown on the right. 
The next Annex.  The letter shown is the next letter on from the one you used last in this document.  It cannot be changed since annexes should be created in order.  It will always be created at the end of the document.
Create an Appendix.  If the check box is ticked to create an appendix, the current annexes are shown to make a choice of where the appendix is required.  The appendix number will automatically be the next one in order.
Landscape Orientation.  By default any new Annex or Appendix is created as a portrait page, but if a landscape orientation is required for this section, then make sure this option is checked.  The new section will then be in landscape with the heading and page number set up accordingly.
Reference.  If the document reference has been entered in the main part of the document, this will be automatically entered.  Otherwise it will be shown as XXXXX.
Date.  The date will again be what has been entered in the main part of the document, which will be the current date by default.  Change it if you wish.
Title.  This is the title for the Annex or Appendix.  This should be entered because:

The text entered will be automatically put into the Annex/Appendix and formatted as a Title Heading for you (bold, left aligned), but will be exactly as you have entered.
Under Defence Writing rules, the reference to an Annex or Appendix appears at the bottom of the parent section.  Thus an Annex to the main document will be referenced in that main document by an entry at the end which shows the Annex letter and the title.  This will be set up automatically from the text you enter.
When entering text, simply enter it as normal with a first capital letter and then capitals for proper names or initials.  The title in the Annex/Appendix itself will be formatted as a Title Heading and the reference text in the entry at the bottom of the main section will be the text you enter, but with a full stop at the end.
If specific words are required to be all capital letters, then enter them as capitals in this dialog and they will not be converted for the reference entry at the bottom of the parent document.  Be careful because an entry that is all capitals will appear as all capitals in both places!
NB - Once the Annex/Appendix has been created, any revisions to the title heading will have to be manually transferred to the reference entry in the parent document.
Any Protective Markings/Descriptors already inserted in the document will be carried forward into the Annex or Appendix.  Should you for any reason want a particular Annex or Appendix to have a different protective marking to the main text, then create the Annex or Appendix in the usual way and afterwards go into the header and/or footer of that particular Annex/Appendix and manually change the protective marking or descriptor as required.  This will not affect the rest of the document.  The page number will also be automatically inserted correctly.

[bookmark: _Protective_Markings/Descriptors][bookmark: _Ref385260720][bookmark: _Ref385261076][bookmark: _Toc80273963]Protective Markings/Descriptors  
[image: ]Protective Markings (or Security Classifications) and Descriptors are text phrases in the header and/or footer of a document to denote its status.  Under the guidelines outlined in the Government Security Classifications document, May 2018, there are 3 classifications – TOP SECRET, SECRET and OFFICIAL with an addendum to OFFICIAL to make OFFICIAL-SENSITIVE.  These may be annotated with a descriptor which may vary depending on the organisation, but 3 are given in the guidelines as COMMERCIAL, PERSONAL and LOCSEN.  Thus a document might be OFFICIAL on its own or with a descriptor added as in OFFICIAL - COMMERCIAL etc.  This template includes the caveat UK / US EYES ONLY as well for convenience.
To add Protective Markings/Descriptors to your document, just choose the button on the Ribbon Add Protective Markings or use the hot-key Alt+V
A dialog box will be displayed as shown.
The text does not have to be a protective marking or descriptor of course, but this function is really designed for this purpose.  If you require the entries to be bold, then make sure that option is selected.
Any new Annexes and Appendices created will also retain any entries made, but will of course have the correct page number format and if there is a cover sheet, there will be the option to include the marking or not.
To change or remove the protective markings, simply choose the option again and change or remove the text.  If the text is removed then the document will be re-formatted correctly.

[bookmark: _Changing_Line_Spacing,][bookmark: _Toc80273964][bookmark: _Ref385262135]Deleting an Annex or Appendix
[image: ]Occasionally there is the need to delete one of the annexes or appendices.  This is not a straightforward process if the integrity of the document under the JSP101 system is to be maintained.  This is because each annex or appendix has to be placed in a new section so that paragraph numbering can re-start at 1 and the page numbering can change for example.  Also following annexes or appendices should be re-numbered otherwise there will be gaps in the document flow.  All these sections are controlled by Word’s bookmarks and these must be kept intact if the functions written into the JSP101 system are going to work correctly.
The option to delete an annex or appendix is provided under the ‘Structure’ section of the ribbon (or use hotkey Alt+Del) which will do the deletion correctly and maintain the integrity of the document.
A Dialog shown on the right appears with a list of all annexes and appendices that are present in the document.  Simply choose the one you want to delete and click OK.  The help button will open this help file and cancel will do just that.
Please be aware that if you choose to delete an annex, all appendices to that annex will also be deleted.  If you need to keep any text in those parts of the document for use later then you must copy them to a holding document first.
[bookmark: _Toc80273965][image: ]Changing Line Spacing, Alignment and Font
The ability to change Line Spacing, Alignment and Font is an option under Other Functions.  This provides the facility to change the attributes of Line Spacing and Alignment and to alter the Font for the current document with the option of storing a font change as the default for all new documents. 
For example you might prefer to have all paragraphs fully justified rather than the normal left aligned (not strictly Defence Writing of course!), or for a draft document you might want double spacing.  Within the concept of a document formatted with numbered paragraphs, right or centre aligned does not really make sense, so only left and fully justified options are available. 
[image: ]Document Font. Defence Writing rules say that an Arial font of 12 point should be used in normal documents, so this is what is set as a default for any new installation.  However if another font is required for the current document, then there is the option to change it.  A change of font here can also be saved as the default for any new document (see below) if this is required.
At any time choose the option from the Other Functions menu and a dialog box will appear showing the current document settings for Line Spacing, Alignment and Font.  The stored default font is also shown.  Choose the required values and then click OK.  The whole document will be re-formatted accordingly.
Default Font.  If a new default font is required for all new documents, then this can be set as well.  Simply change the font and size to what you require as the new default click OK and a dialog box will be displayed allowing you to set the new font as the default.  If 'Yes' is chosen from the dialog, both font and size will be stored as the new defaults.  This default will NOT affect existing documents.

[bookmark: _Reset_Dialogs_to][bookmark: _Toc80273966][bookmark: _Ref385258814][bookmark: _Ref385258724][image: ]Reset Dialogs to be Visible
There are 2 dialog forms that give information/help to explain certain functions within the system.  Once read and understood, they can be disabled via a check box on the dialog itself.  This ribbon option under Other Functions allows the dialogs to be reset so that they are visible once again, should that be required.  The 2 dialogs are as follows:  On opening a new document based on one of the templates, there is a dialog explaining the grey prompts which are there to guide the user about content; the other dialog explains the function to correct paragraph numbering where this has gone wrong – see Wrong Paragraph Numbering.


[bookmark: _Toc80273967][image: ]Check for New Version 
This option from the Other Functions menu simply checks on the source website whether there is a newer version of the system than the one currently installed.  If there is, there is the option of downloading and installing it.  This check is also performed whenever Word is started.

[bookmark: _Applying_the_Template][bookmark: _Toc80273968]Applying the Template to an Existing Document
Open the document that you want to apply the template to and from the ‘Add-Ins’ option on the ‘File’ tab choose ‘New JSP101 Documents’ and then the option to Apply JSP101 Template.

NOTE this option will not do anything if the current document is already based on the JSP101 template.

NB   The fonts in your current document may be changed to the template default values.

This facility is useful, for example, if you have a template already set up that gives you a particular layout that you use and you wish to have the JSP101 facilities, such as automatic paragraph numbering, as well.  Open a new document based on the other template and then when the new document has appeared choose the Apply JSP101 Template option as described above.  You now have your usual document with all the facilities of the JSP101 system added.

NB   Any macros from the first template will be lost.

If you want different page settings, such as margins etc, to those set up automatically, then start a blank document and change any settings to what is required before using this option.  The settings will be saved with the document.

NB   Any re-formatting of the original paragraphs will have to be done manually.

[bookmark: _Document_Templates][bookmark: _Toc80273969]Document Templates
The Defence Writing Guide suggests 6 document types – Agenda, Minutes, Brief, Note, Submission and Letter.  Refer to the new guide for information on these.
[image: ]Using the Templates
When the software is installed, there will be 2 new options available when Word is opened.  In Word 2010 and later they appear under the 'Add-Ins' option on the 'File' tab.  The top one New JSP101 Documents gives 3 options for new documents.  The top option opens a new blank document with the JSP101 facilities attached.  This is for general purpose reports to be written to Defence Writing standards.
Choosing ‘New Document’ will give the choice of the 6 templates available – Agenda, Minutes, Brief, Note, Submission and Letter.  Click the one you want and a new document based on that template will open ready for editing with the date and page number inserted.
See ‘Apply JSP101 Template’ for information about the third option.

Editing the Templates
You will usually need to edit the templates after installation because you will want to have the correct name, contact details,  telephone numbers etc. and also to insert a logo into the Letter format.  This is easy to do and can be done at any time, as described below.
[image: ]To edit a template, that template must be opened itself (normally the template is used to create a new document that looks like the template, but any changes will be to that new document and not the template).  To make editing as easy as possible, each of the templates can be opened from the 'Add-Ins' section on the 'File' tab in Word 2010.  Choose the option Edit JSP101 Templates and choose the template you wish to edit and it will be opened for you.

REMEMBER that you are now editing the actual template itself, so be careful what you change.  Normally you will simply want to alter the details to personalise the template for you and you will probably need to replace the given logo on the Letter Template.
When you have finished, save the changes and close the template.  All changes will be stored correctly in the template so that when you select it next time to create a new document, all the details will be correct.
Grey Prompts
It is recommended that you do not change any of the grey prompts that are between square brackets [ ] while editing the templates.  They are there to give general guidance about content and should be changed in the actual document, not here in the template.

[bookmark: _General_Rules_for][bookmark: _Ref385260153][bookmark: _Toc80273970]General Rules for Ease of Use
Remember the facilities in the software are NOT mandatory and do NOT enforce any numbering rules.  They are there to make life easier if you need to have your document formatted to the Defence Writing standard, so use those facilities you need and do not worry about the others.
Get used to changing the paragraph style and numbering level easily from one to another so that if you do not like the way a paragraph looks, change it.  Remember there are 2 ways to achieve this, so use the method you like most:
Buttons on the Ribbon
Hot-Key Shortcuts

[bookmark: _Using_TAB_and][bookmark: _Toc80273971]Using TAB and ENTER
The system 'understands' what level of numbered paragraph you are currently in and detects that the TAB or ENTER key has been pressed at an empty paragraph.  If TAB is used on an empty numbered paragraph, the next lower level of numbering is automatically set; if ENTER is used the next higher level is automatically set.
To explain this, assume you are entering text at sub-paragraph c. to paragraph 6. and on pressing ENTER you get sub-paragraph d. automatically as shown below
[image: d:\HELPSYS\JSP101\word2007\Paraex.bmp]
Here sub-paragraph d. is an 'empty' numbered paragraph – there is no text in it – so if TAB is pressed, the next lower level of numbering will be automatically selected – in this case sub paragraph (1).  If ENTER is pressed, the paragraph will automatically change to the next higher level with the appropriate number – in this case 7..  This works the same whatever level you are working on, but if ENTER is pressed at an empty top level paragraph, the numbering is turned off and the paragraph becomes a normal no numbered paragraph.
Anywhere else, pressing the TAB key will insert a normal TAB.
Remember that the software is set-up to format the document to the Defence Writing standards as far as possible, but that it cannot do everything automatically.  Some things will always be quicker and easier to do by using the normal Word facilities, so use the methods that are most appropriate.

[bookmark: _Toc80273972][bookmark: _Ref385262539]Creating a Footnote
If you want to create a footnote in your document, place the cursor in the place where you want the reference number to appear – usually at the end of the word where you want the footnote to expand on more detail – and then click the button on the ribbon Create New Footnote or use the keyboard shortcut Alt+F. There will be a warning dialog to check that the cursor is correctly placed and you want to continue and then you will be asked to enter the text you want in the footnote itself.  When you click OK the footnote will be inserted at the bottom of the page correctly formatted.

[bookmark: _Adding_a_Cover][bookmark: _Toc80273973]Adding a Cover Sheet
If you want to add a cover sheet to the beginning of your document then click the button on the ribbon Add/Delete Cover Sheet or use the shortcut Alt+C.  You can only add one cover sheet, so if there is already one there you will be offered the chance to delete it otherwise a new one will be created.  The cover sheet will have no page numbering, but you can manually add one if you wish (some organisations use roman i on a cover sheet).  If there is any protective marking already in the document, you can choose to have on the cover sheet or not.  This can be changed at any time by using the Add Protective Markings option on the ribbon which will allow the cover page to have the marking or not.

[bookmark: _Inserting_Tables_or][bookmark: _Toc80273974]Inserting Tables or Drawings
If you want to insert anything into your document that does not require paragraph numbering or other formatting, then change to an un-numbered style before you do the insertion.  This will be the case for pictures, tables, drawings etc, or when writing letters where numbered paragraphs would not be appropriate.
You change to an un-numbered style very simply by clicking the button on the Ribbon.  This gives 2 options - one with a following blank line and one without.  The alternative Hot-Key is Alt+N for Normal Style (with no following blank line) or Alt+P for Plain Text Style (with a following blank line).  Remember the easiest way of all when you are in a numbered paragraph is to press ENTER to get a new 'empty' paragraph (if not already there) then press ENTER again to turn numbering off.
So to insert a table for example, complete the paragraph prior to it (most usually the lead-in text explaining what the table is concerned with), press the ENTER key to end the paragraph which will give you the next paragraph number and press ENTER again to change to un-numbered style.  Now simply insert your table.
When you want to start the next numbered paragraph following the table (or drawing etc) merely press ENTER if required to get you to the right place then use the relevant Hot-Key or Ribbon button to turn numbering back on.


[bookmark: _Toc80273975]Writing a Group Report
If you have to produce a group report, that is each member of the group being responsible for writing a separate part, then keep it straightforward.
Everyone should work with the same layout, margins, page size etc (If you do not then it will just make life more difficult later!) and with the same default formatting.
Each person should write their part as an individual document using the JSP101 template.  The top level paragraph numbering will obviously not be correct, but this will sort itself out later.  The important thing is for each part to be written using the proper styles.
If there are Annexes then create the annexes with the last part of the main document.
It is quite all right to include all the tables or drawings required in the individual parts, but take note of the tips shown in Inserting Tables or Drawings.
When you are ready to assemble all the parts together read the next section.

[bookmark: _Toc80273976]Creating a Single Document from Two or More Parts
If you have a number of individual documents that you want to assemble into a single work, such as a group report, then do as follows.  It is assumed that common sense has been used and the tips in Writing a Group Report have been followed!!
It is better if you assemble the final document in the right order.  This is not strictly necessary as the paragraph numbering will sort itself out whether you insert in the middle of another document or at the end.  However.......
Load the first part into Word and go to the end of that document (Ctrl+End) and make sure the final paragraph is an un-numbered one (see Turning off Paragraph Numbers).
From the Insert Ribbon tab click the down arrow next to ‘Object’, choose ‘Text from File…’ and then select the next part to be incorporated.  This will be read in and all the paragraph numbers will be re-formatted correctly (assuming the new part was created using the JSP101 template of course!).
Do exactly the same now for all the parts of the overall document.  The key really is to make sure the cursor is in exactly the right place of the current document and that the paragraph is Normal style before you insert the next part.
When the whole document is assembled it will need to be checked, especially where the joins have occurred and especially for paragraph numbering that is not correct (see Wrong Paragraph Numbering).
If the Annexes have been created as part of the final bit of the document, the reference section showing the Annex letters and their titles will have been created for you  so follow exactly the same rules as for bringing in the other parts and you will find you have the required references to the Annexes inserted in the right place at the end of the main document!  If you want to keep the Annexes as separate documents, create each annex structure in your now assembled document and copy and paste the annex text in its correct place.  In this way all the correct sections and page numbering should work!
WARNING   All Annexes and Appendices are created as new sections so that the page numbering can change.  This will be set up automatically, but when Word reads in a file that contains different sections it has the habit of changing the linking of headers and footers!!  Always check your assembled document if you have any Annexes/Appendices and make sure each section footer IS NOT linked to the previous one.

To do this, start at the last section (go to end of document - Ctrl+End), choose the Footer option from the Insert tab on the ribbon and click Edit Footer.

Check to see if the words Same as Previous appear on the top right of the footer box:

If they do, then turn off the link first and then correct the page number format if necessary:

Now repeat the process by clicking the Show Previous button:

[bookmark: _Toc80273977]The Author
This software has been written by Robin Lavies, a former Army Officer in the Royal Engineers and then Senior Lecturer at the Royal School of Signals at Blandford.  He can be contacted as follows:
	robin@rlavies.co.uk
Please note – every effort has been made to ensure that the software works the way it is intended, but the author takes no responsibility for misuse or for any damage caused to user’s documents by using the software.  I’m sorry, but it can’t be blamed for a bad document!
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